
Badia Duplica XT
Powerful XTensions software for copying, 
pasting and duplicating attributes and items
in QuarkXPress 4.

User’s Guide and Tips

Version 1.0



Badia Duplica XT
Powerful XTensions software for copying, 
pasting and duplicating attributes and items 
in QuarkXPress 4.

Version 1.0

User’s Guide and Tips



Badia Duplica XT User’s Guide and Tips

Copyright ©1998 by Badia Software. All Rights Reserved. No part of this book, including design, may be 
reproduced or transmitted in any form, by any means (electronic, photocopying, recording, or otherwise) without
the prior written permission of Badia Software.

Liability
The information in this book is distributed on an “As Is” basis, without warranties or guaranties of any kind.
While every precaution has been taken in the preparation of this book, Badia Software shall have no liability to
any person or entity with respect to any loss or damage caused or alleged to be caused directly or indirectly by the
instructions contained in this book or by the computer software described in it.

Credits
Contents, design and typesetting: Dario Badia
Editing: Ian Scott

Trademarks
Quark, QuarkXPress, QuarkXTensions and XTensions are trademarks of Quark, Inc. and all applicable affiliated
companies, Reg. U.S. Pat. & Tm. Off. and in many other countries. The Quark logo and the XTensions logo are
trademarks of Quark, Inc. and all applicable affiliated companies. Mac OS is a trademark or Apple Computer, Inc.
All other trademarks are the properties of their respective owners.

Badia Duplica XT

Copyright ©1998 by Badia Software. All Rights Reserved. 
Portions Copyrighted 1988–1998 Quark Technology Partnership. All Rights Reserved.
Badia Duplica XT is for use with Mac OS QuarkXPress version 4.03 or higher, for the English language, and can
only be used with a valid, registered copy of QuarkXPress.

Liability
Badia Duplica XT software is distributed on an “As Is” basis, without warranties or guaranties of any kind. Badia
Software shall have no liability to any person or entity with respect to any loss or damage caused or alleged to be
caused directly or indirectly by use of the software.

Credits
Original idea and development: Dario Badia
Quality Assurance: Nigel Allen
Beta testing: Achille Lombardi, Sylvia Schlittke

The following disclaimer is required by Quark, Inc.
QUARK, INC. MAKES NO WARRANTIES , EITHER EXPRESS OR IMPLIED, REGARDING THE ENCLOSED SOFTWARE
PACKAGE, ITS MERCHANTABILITY, OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. QUARK DISCLAIMS 
ALL WARRANTIES RELATING TO THE ENCLOSED SOFTWARE PACKAGE. ALL OTHER WARRANTIES AND 
CONDITIONS, WHETHER EXPRESS, IMPLIED, COLLATERAL, MADE BY THE DISTRIBUTORS, RETAILERS OR
DEVELOPERS OF THE ENCLOSED SOFTWARE ARE DISCLAIMED BY QUARK, INCLUDING WITHOUT LIMITATION,
NON-INFRINGEMENT, COMPATIBILITY, OR THAT THE SOFTWARE IS ERROR-FREE, OR THAT ERRORS CAN 
OR WILL BE CORRECTED. SOME JURISDICTIONS, STATES, OR PROVINCES DO NOT ALLOW LIMITATIONS ON
IMPLIED WARRANTIES, SO THE ABOVE LIMITATION MAY NOT APPLY TO PARTICULAR USERS.

REGARDLESS OF WHETHER ANY REMEDY FAILS OF ITS ESSENTIAL PURPOSE, IN NO EVENT SHALL QUARK 
OR ANY ENTITY WHICH CONTROLS, IS CONTROLLED BY, OR IS UNDER COMMON CONTROL OF QUARK BE
LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES, INCLUDING,
BUT NOT LIMITED TO, ANY LOST PROFITS, LOST TIME, LOST SAVINGS, LOST DATA, LOST FEES, OR EXPENSES
OF ANY KIND ARISING FROM INSTALLATION OR USE OF THE SOFTWARE OR ACCOMPANYING DOCUMENTA-
TION IN ANY MANNER, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. IN ANY EVENT, QUARK’S
LIABILITY RELATING TO THE SOFTWARE SHALL BE LIMITED TO FIFTY DOLLARS ($50) OR THE AMOUNT PAID
BY USER TO QUARK, WHICHEVER IS LESS. THESE LIMITATIONS WILL APPLY EVEN IF QUARK HAS BEEN
ADVISED OF SUCH POSSIBLE DAMAGES. SOME JURISDICTIONS, STATES, OR PROVINCES DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE LIMITATION OR
EXCLUSION INCLUDED IN THIS LICENSE AGREEMENT MAY NOT APPLY TO PARTICULAR DEVELOPERS.

THIS PRODUCT WAS NOT WRITTEN OR REVIEWED BY QUARK.

Badia Software
392 Sherbourne St., Suite 802
Toronto, Ontario info@badiasoftware.com
Canada M4X 1K3 www.badiasoftware.com



Table of Contents

1. Introduction 1
How Duplica Integrates with QuarkXPress 2

2. Copying and Pasting with Duplica 5
Copying and Pasting Character Attributes 5

List of Character Attributes 6

Example 6

Copying and Pasting Paragraph Attributes 9

List of Paragraph Attributes 9

Example 10

Copying and Pasting Unstyled Text 11

Copying and Pasting Picture Attributes 11

List of Picture Attributes 12

Example 12

Copying and Pasting Box Attributes 14

List of Box Attributes 15

Examples 16

Copying and Pasting Line Attributes 20

List of Line Attributes 20

Examples 22

Copying and Pasting Page Attributes 25

Using Next Paste 25

3. Cloning Boxes and Lines with Duplica 28
Specifying Incremental Offsets 29

Rotating an Item Around a Point 29

Specifying Copies 30

Cloning “Zero Copies” 31

Examples 32

Appendix: Warnings and Error Messages 39

v



1. Introduction
Badia Duplica is an XTension for Mac OS QuarkXPress 4.0 that

expands the functions of copying, pasting and duplicating attributes

and items, allowing you to:

• copy almost any kind of attribute applied not only to characters

and paragraphs, but pictures, boxes, lines and pages as well, 

and paste them into other parts of the same or another document

without altering the contents of the Clipboard;

• copy unstyled text (text without character or paragraph attributes)

and paste it elsewhere, applying the text attributes of the new

insertion point; 

• clone boxes and lines any number of times, and specify not only

an offset, but several of their attributes as well, including width,

height, angle, skew, corner radius, frame and shade;

• paste cloned copies behind or in front of the previous clone;

• clone and rotate boxes and lines around a point within the page;

• repeat the last paste or clone action with a single keystroke. For

example, if you have to change the font of several non-contiguous

words, you can just keep “pasting” the new font attribute that

you previously copied. 

By attribute we mean a characteristic that defines and changes the

way text, pictures, items and pages in a document look or behave.

You are already familiar with several text and paragraph attributes,

such as font, type style and leading. Duplica expands the category 

of attributes further to include picture, box, line and page attributes.

Thus, with Duplica the scale and offset of a picture are picture

attributes; the angle and background color of a box are box attrib-

utes; the width and style of a line are line attributes; the horizontal

and vertical guides are page attributes. There are a total of 82 

different attributes that you can choose from and combine.

Copying attributes means that you can retain attributes temporarily

from a document element and apply or paste them into other 

elements later on. Duplica does not use the Clipboard to store these

attributes – instead think of having additional clipboards that 

maintain related attribute information: a clipboard for storing text

attributes, one for paragraph attributes, one for box attributes, 

and so on. These attribute clipboards act independently from each

other and their contents remain unchanged until you override them
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An attribute is a charac-

teristic that defines and

changes the way text, 

pictures, items and pages in 

a document look or behave.

The size and color of 

the text are text attributes,

whereas the frame and 

the blend color of a box are

box attributes. 



by doing a new copy operation, or until you quit QuarkXPress. In

this way, you can close and switch documents and still paste the

attributes that you copied previously.

With the Step and Repeat command in QuarkXPress you can dupli-

cate items, specifying an offset for each step. With Duplica’s Clone

command, you can specify several other attributes as well that 

can change in each step: width, height, angle, skew, corner radius,

line width, item shade, frame width and frame shade. By using 

incremental offsets, each duplication will add the specified amount

to the selected attribute every time a new cloning is performed. 

For example, you can clone a box 10 times with an angle offset of

5°: each step will not only duplicate the box, it will rotate it 5°

from the previous one. 

You can also clone an item by rotating it around a point within a

page and apply any of those offsets in each rotation. As well, you

can specify whether to paste the cloned copies behind or in front of

the previously cloned item.

How Duplica Integrates with QuarkXPress

At Badia Software we believe that integration with QuarkXPress is a

crucial part in the development of an XTension. For starters, Duplica

can Undo and Redo paste and clone operations just the way you

expect it to – with no hidden surprises.

Most of the commercial XTensions available today don’t give you

the opportunity to undo the XTension operation you just performed.

You are forced to save the document first, just in case you are not

satisfied with the results. Others have an ‘Eraser’ or similar tool, but

may behave awkwardly, and there are always cases in which you

cannot use the tool or in which the results are unpredictable. Duplica

takes a simple and straightforward approach: it makes it feel as 

if it’s just another QuarkXPress command that has been performed.

Just press Command-Z or select Undo from the Edit menu. Press

Command-Z or select Redo from the Edit menu to redo the opera-

tion again. 

Duplica also makes your QuarkXPress experience easier by offering

for the first time a contextual pop-up menu that shows up when you

hold the Shift and Control keys and click anywhere in a document.
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Pressing the Shift and
Control keys changes 
the XPress cursor to
Duplica’s pop-up cursor.

Unlike other commercial
XTensions, Badia Duplica
can undo and redo paste
and clone operations just
the way you expect it to – 
with no hidden surprises.

A box cloned 4 times with
Width, Height and Angle
incremental offsets.



Duplica’s pop-up menu appears only when you need it and it 

gets out of the way when you don’t. No need to open new 

floating palettes that clutter your already packed

working screen. 

Note that certain menu items are dimmed:

Duplica shows you all the possible options, but

you can select only the ones that are applicable

to the current selection in the document. 

You won’t have to remember any new keyboard

commands either. Duplica shares common key-

board commands and menu items with QuarkXPress and adds 

just a couple of new menu items. Here are the modified Edit 

and Item menus:
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Copy hierarchical
submenu

Shared Paste
menu item 

and keystroke

New menu item

Shared
Duplicate and
Clone Again
menu items and
keystroke

New menu item

Duplica integrates seam-
lessly with QuarkXPress 
and incorporates the 
first pop-up contextual
menu in the history 
of Quark XTensions.

Sharing a menu item indicates that its meaning changes depending

on whether the last operation was a QuarkXPress operation or a

Duplica operation. For instance, after copying paragraph attributes,



Paste or Command-V means “Paste Paragraph Attributes.” If you

now copy text to the Clipboard, Paste retains its XPress meaning of

“Paste the Contents of the Clipboard.” Similarly, after cloning an

item, Duplicate or Command-D changes to Clone Again. After using

the XPress Step and Repeat command, Clone

Again switches back to Duplicate.

A unique and powerful Duplica feature allows 

you not only to store Copy operations in separate

“clipboards,” but also to switch between them,

specifying which one will be used the next time you

perform a Paste operation. You do this by using

the Next Paste submenu which is discussed later.
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The Next Paste submenu
allows you to specify what
will be pasted the next
time you perform a Paste
operation.



2. Copying and Pasting with Duplica
In addition to copying and pasting text and items “the old-fashioned

way,” you can now copy and paste a variety of attributes without

changing the contents of the Clipboard.

Copying and Pasting Character Attributes

If you select a character or group of characters,

you will be able to duplicate their attributes and

paste them into other sections of the document.

Choosing Copy Character Attributes brings up

this dialog:

You can select any combination of these attributes by checking 

or unchecking their respective check buttons. Only the attributes that

you choose will be copied and duplicated when you perform Paste

later on in other parts of the document.

If you select text that has different instances of the same attribute (for

example, the color attribute, but different colors), that attribute 

will be dimmed, telling you that you cannot copy it. In the following

example, the selection contains different instances of each of the

attributes Font, Color and Size.

You cannot copy the Font, Color and Size attributes because the selection 
contains different instances of each of those attributes.
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Duplica Tip
Every Duplica attribute 

dialog has the buttons All
and None. Clicking All
will select all the possible

attributes; clicking None
will deselect them all. Note

that in order to OK a 

dialog, at least one check

button must be checked.



Duplica offers an easygoing approach when there are conflicting

attributes – it lets you copy and paste as many attributes as 

it can. Other commercial XTensions do not allow you to copy at

all, or they give you a message “punishing” you for what you

have just selected.

List of Character Attributes 

Font The characters’ Font. You can paste this attribute even after

the font is no longer available in your system (though a substitute

font will be used).

Type Style The characters’ Type Style, such as Bold, Underline, 

etc. Note that overriding a type style with the same style will toggle 

the style on and off. For example, if you paste the Italic style into

text that already has Italic applied, you will be converting the text 

back to Roman.

Color The characters’ Color. You cannot paste this attribute if the

color no longer exists in the document after it gets copied (for 

example, if you delete the color or switch to a document that does

not contain the color).

Shade The characters’ Shade.

Size The characters’ Size.

Scale The Horizontal or Vertical (but not both) characters’ 

Scale percentage.

Track The characters’ Track. Note that you can even copy this 

attribute if the selection contains only an insertion point: the track

will be copied, not the kern.

Baseline Shift The characters’ Baseline Shift, as a percentage of 

the original type size. Note that pasting this attribute into text with

different sizes will result in different baseline shifts.

Example

Changing the Color and Font in one column of a table

Let’s suppose you have the following QuarkXPress table and 

you want to quickly change the 1997 figures to a bolder font in a

different color:
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Duplica Tip
When you copy the

Baseline Shift character

attribute, its value is

expressed as a percentage

of the selected text 

type size. That percentage 

is then used when you 

perform Paste.

QuarkXPress Tip
When you have to “squeeze”

a line of text to make it 

fit within a box, try not to

change the tracking too

much, since the difference

may become obvious.

Instead, change the Hori-

zontal Scale to, say, 98%

(1 Option [ decreases 

the scale by 1%) and/or

the Word Space Tracking 

(1 Option Shift Control [
decreases the word space 

by 1 track unit). (You will

need the free Type Tricks
XTension to apply word

space tracking.)



1997 1996 1995

$ 12,827 $ 4,000 $ (15,992)

33,508 33,980 35,909

11,822 8,679 7,202

3,154 1,433 724

15,380 7,965 (2,046)

$ 72,294 $ 49,599 $ 22,997

Though you could create a character style sheet, there’s an even 

easier and faster way using Duplica’s Copy Character Attributes.

Begin by changing just one of the figures into the new font and 

color (in this case, “1997”):

1997 1996 1995

$ 12,827 $ 4,000 $ (15,992)

33,508 33,980 35,909

11,822 8,679 7,202

3,154 1,433 724

15,380 7,965 (2,046)

$ 72,294 $ 49,599 $ 22,997

Hold down the Shift and Control keys to bring up Duplica’s 

pop-up menu:

1997 1996 1995

$ 12,827 $ 4,000 $ (15,992)

33,508 33,980 35,909

11,822 8,679 7,202

3,154 1,433 724

15,380 7,965 (2,046)

$ 72,294 $ 49,599 $ 22,997

Select Copy Character Attributes and, when the dialog appears,

check Font and Color:
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QuarkXPress Tip
Always choose the font

weight from the Font menu

instead of changing the

type style to bold or italic.

Though this might seem

slower, it guarantees that

the font weight does exist

and that it will print cor-

rectly. Also, if you are using

kerned font sets, there 

may be different values for

each of the weight pairs,

which will not be applied if

you use the regular font

and then change its type

style to bold or italic. 



Now, select “$ 12,827” in the next line. Choose Paste or press

Command-V:

1997 1996 1995

$ 12,827 $ 4,000 $ (15,992)

33,508 33,980 35,909

11,822 8,679 7,202

3,154 1,433 724

15,380 7,965 (2,046)

$ 72,294 $ 49,599 $ 22,997

Continue selecting the remaining items in the column and choose

Paste or Command-V until you reach the last line:

1997 1996 1995

$ 12,827 $ 4,000 $ (15,992)

33,508 33,980 35,909

11,822 8,679 7,202

3,154 1,433 724

15,380 7,965 (2,046)

$ 72,294 $ 49,599 $ 22,997  
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Duplica Tip
Duplica “remembers” the

buttons that you checked

after closing a dialog. Next

time you perform a copy

operation, those options

will be checked by default.

(Click the None button if

you want to start over.)

Duplica vs. Style Sheets

At this point, you may be asking yourself, Is Duplica a replacement for XPress’ paragraph and character 
style sheets?

The answer is, of course, no. Duplica was created to complement XPress’ style sheets, not to replace
them. You should use style sheets as much as possible, because they help make the document more 
consistent in style and it’s a breeze to make global document changes.

However, there are lots of cases in which style sheets may not be the final answer – when creating an ad,
for example, in which several styles may be used but each appears only once or twice. 

Or when you want to copy only paragraph rules from one paragraph to another. Creating a style sheet with
rules only is impossible: you have to specify all the other paragraph settings as well.

And of course, let’s face it, we all begin creating style sheets religiously, but after a document gets
revised and edited (and the client wants to see a proof right away), you may end up having text here 
and there that has no style sheets applied. Or you may have hundreds of style sheets with names like 
caption 1, caption new, ...

Those are the cases in which Duplica comes in handy: a quick way to duplicate the type settings from one
place to another. 

More importantly, Duplica expands this concept beyond character and paragraph settings to include 
picture, box, line and page attributes, something that is not possible using XPress style sheets. We will
explain this later.

■



Copying and Pasting Paragraph Attributes

When a paragraph or group of paragraphs is selected, choosing

Copy Paragraph Attributes brings up this dialog:

If you select several paragraphs, some of the attributes may be

greyed-out, indicating that there are different instances of that

attribute. Also, if the selection contains no tab stops, the Tab Stops

attribute will be disabled.

List of Paragraph Attributes

Left Indent The paragraph Left Indent.

First Indent The paragraph First Indent.

Right Indent The paragraph Right Indent.

Leading The paragraph Leading.You can copy and paste absolute,

relative and auto leadings.

Space Before The paragraph Space Before.

Space After The paragraph Space After.

Rule Above The paragraph Rule Above complete settings, such 

as Width, Color, etc. This option will be dimmed if the selection

contains several paragraphs with rules above that have conflict-

ing settings.

Rule Below The paragraph Rule Below complete settings, such 

as Width, Color, etc. This option will be dimmed if the selection
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Duplica Tip
You can undo and redo
paste paragraph operations

by simply pressing 1 Z
or, from the menu, Edit ->
Undo/Redo Paste.



contains several paragraphs with rules above that have conflict-

ing settings.

Tab Stops The paragraph Tabs, including Position, Fill and 

Align characters.

Alignment The paragraph Alignment.

H&J The paragraph Hyphenation and Justification.

Drop Caps The paragraph Drop Caps, including Character and 

Line Count. 

Lines Together The paragraph Keep Lines Together, including All

Lines In ¶ and Start and End counts. 

Keep with Next The paragraph Keep with Next ¶.

Lock to Grid The paragraph Lock to Baseline Grid.

Example

Copying and pasting tab settings

There are plenty of occasions when you want to copy the tab setting

from one paragraph to another, even from different stories or 

documents. If the paragraph is in the same story, you could use the

keyboard command Option Shift Click to copy the tabs, but this

also copies all the other paragraph settings, including rules, etc. 

Duplica allows you to copy and paste only the tabs from a story 

or document and paste them somewhere else. Place the cursor any-

where in the paragraph whose tabs you wish to copy and select

Copy Paragraph Attributes. When the dialog shows up, check only 

Tab Stops:

Now, insert the cursor anywhere in the paragraph in which you

want to place the tabs, or select a group of paragraphs, and choose

Paste. That’s it! All the tab settings will be pasted. ■
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QuarkXPress Tip
The document’s View
percentage determines the

number of decimals used

when placing and modifying

XPress tabs manually

(rather than mathemati-

cally). For example, with

pica units, at 100% view

scale you can move tabs

with 1pt increments; at

200%, .5pt increments; at

300%, .333pt increments;

at 400%, .25pt increments

and at 800%, .125pt incre-

ments. Any other irregular

percentage view will result

in useless decimals.



Copying and Pasting Unstyled Text

In QuarkXPress, if you copy text and then paste it somewhere 

else, its attributes also get pasted. Though this can be handy in certain

cases, there are times when you wish you could copy only the 

characters and apply the attributes already in use in the area where

you are pasting them. 

You can do this now with Duplica: select the text

whose characters you want to copy and choose

Copy Unstyled Text. Locate the place where you

want to place it, select Paste or Command-V. 

The pasted text now has the attributes of the new

insertion point.

Remember that the contents of the Clipboard are

not altered when you copy unstyled text. As well, you can always

undo and redo the paste operation. 

Note: You can copy and replace up to 50,000 characters at once. If

you try to copy more, only the first 50,000 characters will be copied. ■

Copying and Pasting Picture Attributes

Duplica allows you to copy and paste picture attributes, much 

the same way you can copy and paste character and paragraph

attributes. For example, the Offset and the Color of a picture 

are picture attributes.

Choosing Copy Paragraph Attributes brings up this dialog:
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Duplica Tip
You can either use 

Duplica’s pop-up menu 

or Edit -> Copy -> 
Picture Attributes.



You can copy picture attributes only when a picture box is selected

with the Contents tool and the box contains a picture. However, you

can paste picture attributes even if the picture box is empty.

List of Picture Attributes

Offset The picture Offset Across and Offset Down within the 

picture box.

Scale The picture Scale Across and Scale Down.

Angle The picture Angle.

Skew The picture Skew.

Negative The picture Negative setting. Only available if the picture

format allows this control. 

Halftone The picture Halftone settings, including Frequence, 

Angle and Function. Only available if the picture format allows 

this control. 

Color The picture Color. Only available if the picture format allows

this control. 

Shade The picture Shade. Only available if the picture format

allows this control. 

Flipping The picture Flip Horizontal and Flip Vertical. 

Suppression The Suppress Picture Printout status. 

Note: The current version of Badia Duplica does not support 

copying and pasting the Contrast or Clipping picture attributes. ■

Example

Replacing a low-resolution picture with a high-resolution picture, 
retaining the settings and cropping

Let’s suppose you have a low-resolution picture that you have

cropped and scaled for position only. You now want to replace it

with the high-resolution version of the image retaining the settings

of the low-resolution image.

continues
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A low-resolution picture
placed for position only.

QuarkXPress Tip
When using Get Picture to
import a TIFF image, if you

hold the 1 key and click

Open, a color TIFF image

will be imported as a gray

scale image, and a gray

scale image will be imported

as a bitmap image.



Select the low-resolution picture with the Contents tool and choose

Copy Picture Attributes:

When the dialog shows up, click the All button to check every 

possible picture attribute:

Now, import the high-resolution picture into the picture box:

With the picture still selected, choose Paste or Command-V:
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This example assumes that

the dimensions of both 

the low- and high-resolution

pictures are the same.

Duplica Tip
Every Duplica attribute 

dialog has the buttons All
and None. Clicking All
will select all the possible

attributes; clicking None
will deselect them all. Note

that in order to OK a 

dialog, at least one check

button must be checked.

■



Copying and Pasting Box Attributes

Duplica allows you to copy and paste a variety of attributes for all

kinds of boxes, including anchored boxes. When a box is selected –

either with the Item or Content tool – you can choose Copy Box

Attributes. The following dialog appears:

You can copy box attributes only when a single box is selected, 

not a group of boxes. However, you can paste box attributes into a

single or group of boxes.

When you paste a certain box attribute with Duplica, all the other

attributes that you are not pasting remain unchanged. For example,

if you paste only the Angle attribute, the across and down offsets of

the box will still be the same.

We copied the Angle attribute from the box on the left and pasted it onto the 
picture box. Note that the X and Y coordinates of the picture box remain the same
– only its angle has changed.
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before after

Duplica Tip
When you Paste a certain

box attribute with Duplica,

all the other attributes that

you are not pasting remain

unchanged.



List of Box Attributes

Origin Across The box Origin Across, measured from the left side

of the page (not the spread). This is an absolute value, independent

of the ruler origin location. You can even copy – but not paste – this

attribute with anchored boxes.

Origin Down The box Origin Down, measured from the top of 

the page (not the spread). This is an absolute value, independent of

the ruler origin location. You can even copy – but not paste – this

attribute with anchored boxes.

Width The box Width.

Height The box Height.

Add Width to Origin Across This is not an attribute per se. When you

check this option, the box width will be added to the origin across

value (only available if you check Origin Across first, and for boxes

with no angle or skew applied).

Add Height to Origin Down This is not an attribute per se. When you

check this option, the box height will be added to the origin down

value (only available if you check Origin Down first, and for boxes

with no angle or skew applied).

Angle The box Angle.

Skew The box Skew.

Corner Radius The box Corner Radius.

Frame The box Frame settings, including Width, Style, Color, Shade

and Gap. When you Paste this attribute, the frame will be drawn

inside or outside the box, depending on the status of the Framing

document preference (Edit -> Preferences -> Document -> General 
-> Framing).

Shape The box Shape, including Rectangle, Rounded-corner, Beveled-

corner, Concave-corner, Oval and Bézier. Note that for Bézier boxes,

in most cases you will select this attribute along with the Points

attribute, to guarantee that the box Bézier points are also duplicated.

Points (Bézier boxes only) The Bézier points that make up the actual

Bézier box. Note that, in most cases, you will select this attribute

along with the Shape attribute, to guarantee that the box is converted
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The Shape attribute refers
to any of these box shapes.

QuarkXPress Tip
When placing and modify-

ing boxes, you can always

use the arithmetic operands

+ (add), – (subtract),

* (multiply), and / (divide)

in any of the box coordi-

nate fields. For example if

you want to make a box 

3 times larger, your could

multiply the W and H fields

by 3 using the * operand:



Duplica Tip

By copying the Shape
and Points attributes from 

the box at top, you can

duplicate the actual “look”

of a box from one box 

to another. Note also that 

the width and height of 

the modified box remain

unchanged.

to a Bézier box. That is, if you paste the Points attribute of a Bézier

box into a rectangular box without pasting the Shape attribute,

nothing will happen, because a rectangular box cannot contain

Bézier points (you must change its shape first).

Columns (Text boxes only) The number of Columns.

Gutter (Text boxes only) The Gutter Width between columns.

Text Inset (Text boxes only) The Text Inset offset.

Text Angle (Text boxes only) The Text Angle.

Text Skew (Text boxes only) The Text Skew.

First Baseline (Text boxes only) The First Baseline settings, includ-

ing Minimum and Offset.

Vertical Align (Text boxes only) The Vertical Alignment settings,

including Type and Inter ¶ Max.

Around All Sides (Text boxes only) The Run Text Around All 

Sides status.

Flipping (Text boxes only) The Flip Horizontal and Flip Vertical

text settings.

Color The box background Color.

Shade The box background Shade.

Blend The box Blend settings, including Style, Angle, Color and

Shade. This is actually the second color used for a blend, so make

sure that you also copy the Color and Shade attributes (for the 

first color) to reproduce the complete blend.

Suppression The box Suppress Printout.

Note: The current version of Badia Duplica does not support copy-

ing and pasting the Runaround box attribute. ■

Examples

Example 1. Placing a box precisely below the last baseline of another box

Let’s suppose you want to place the top of a box exactly at the base-

line of the last line of type of another box. QuarkXpress does not

allow you to determine directly the coordinate of the baseline of the
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before after



last line in a box. If you know the position of the first line baseline,

you can figure this out by counting the number of lines multiplied by

the leading amount. This can sometimes be cumbersome, yet you

can do this easily with Duplica. 

Create a small transparent box with no contents (Item -> Content 
-> None) and, with the Item tool selected, select Cut or Command-X.

Now select the Content tool and paste that box as an anchored 

box at the end of the last line:

Select the anchored box and choose Copy Box Attributes. When 

the dialog shows up, select only Origin Down and Add Height to

Origin Down. (You can now delete the anchored box if you wish.)

Now select the box whose top you want to align with that last base-

line. Choose Paste or Command-V:

You can now place text on the box below at a precise distance from

the last baseline of the other box: just enter the value in the First

Baseline field (Item -> Modify -> Text -> First Baseline -> Offset).

We used 2p6 for this example. ■
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Duplica Tip
You can also use this tech-

nique to place a caption

text box precisely under a

picture box: copy the Origin
Across, Origin Down and

Width of the picture box

and select Add Height to
Origin Down. Select the

text box, and choose Paste
or Command-V. Use First
Baseline offset to place the

first text baseline at a fixed

distance under the bottom

of the picture box.

The top of this box
has been positioned
exactly at the last
baseline of the
other text box.



Example 2. Creating a bar chart

In this example, we are going to create a bar chart and modify its

design using Duplica. Let’s suppose you have the following plain 

bar chart:

Duplicate any of the bars and create a more interesting design. 

In this case, we added a linear blend, and changed its shape from

rectangular to rounded-corner:

continues
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Duplica Tip
Duplica also helps you

ensure consistency across

pages. For example, let’s

suppose you want to make

several boxes that were

placed “by eye” begin at

the same position on differ-

ent pages. Just copy the

Origin Across and Origin
Down attributes of the

“model” box, and then

select Paste or 1 V on each

of the remaining boxes: 

the boxes will all have the

same origin throughout.



With that box selected, choose Copy Box Attributes and check these

options: Corner Radius, Shape, Color, Shade and Blend:

Now select all the bars in the chart and choose Paste or Command-V.

A message will warn you that you will not be able to undo this 

multiple box paste operation. Click OK:

Note that if you change your mind and decide to create a different

design, you can change just one of the bars, copy its box attributes

and paste them into the remaining boxes. ■
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Duplica Tip
When you copy the Shape
attribute of a box with 

corner radius (like rounded-

corner or beveled-corner),

remember to check Corner
Radius as well.



Copying and Pasting Line Attributes

In many ways, lines behave much like boxes. For this reason, you

will see that copying and pasting line attributes is similar to copying

and pasting box attributes. 

As with boxes, you can copy attributes only when a single line is

selected, not a group of lines. However, you can paste attributes into

single or grouped lines. 

When you select any kind of line – including anchored lines – with

the Item or Content tools, you can perform Copy Line Attributes.

This dialog appears:

Depending on the line shape – regular, orthogonal or Bézier – 

you will see that certain options are not available. For example, First

Point and Last Point attributes are only available for regular or

orthogonal lines, whereas Angle, Skew, and Point are only available

for Bézier lines.

Remember also that when you paste a certain line attribute 

with Duplica, all the other attributes that you are not pasting 

remain unchanged.

List of Line Attributes

First Point Across (Regular and orthogonal lines only) The coordi-

nate across of the first point of the line (First Across), measured

from the left side of the page (not the spread). This is an absolute
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Duplica Tip
For regular and orthogonal

lines, the first point
refers to the point that was 

created when you started

dragging the mouse to

build the line, and the last
point is the one you 

created after you finished

dragging.



value, independent of the ruler origin location. You can even copy

and paste this attribute with anchored lines.

First Point Down (Regular and orthogonal lines only) The coor-

dinate down of the first point of the line (First Down), measured 

from the top side of the page (not the spread). This is an absolute

value, independent of the ruler origin location. You can even copy

and paste this attribute with anchored lines.

Last Point Across (Regular and orthogonal lines only) The coor-

dinate across of the last point of the line (Last Across), measured 

from the left side of the page (not the spread). This is an absolute

value, independent of the ruler origin location. You can even copy

and paste this attribute with anchored lines.

Last Point Down (Regular and orthogonal lines only) The coordinate

down of the last point of the line (Last Down), measured from the

top side of the page (not the spread). This is an absolute value, inde-

pendent of the ruler origin location. You can even copy and paste

this attribute with anchored lines.

Origin Across (Bézier lines only) The line Origin Across, measured

from the left side of the page (not the spread). This is an absolute

value, independent of the ruler origin location. You can even copy –

but not paste – this attribute with anchored lines.

Origin Down (Bézier lines only) The line Origin Down, measured

from the top side of the page (not the spread). This is an absolute

value, independent of the ruler origin location. You can even copy –

but not paste – this attribute with anchored lines.

Width (Bézier lines only) The line boundary box Width.

Height (Bézier lines only) The line boundary box Height.

Angle (Bézier lines only) The line boundary box Angle.

Skew (Bézier lines only) The line boundary box Skew.

Shape The line Shape, including Regular, Orthogonal, and Bézier.

Note that for Bézier lines, in most cases you will select this attribute

along with the Points attribute to guarantee that the line Bézier

points are also duplicated.

Points (Bézier lines only) The Bézier points that make up the actual

Bézier line. Note that, in most cases, you will select this attribute

21

Copying and Pasting with Duplica

The Shape attribute refers
to any of these line shapes.



along with the Shape attribute to guarantee that the line is converted

to a Bézier line. That is, if you paste the Points attribute of a Bézier

line into a regular line without pasting the Shape attribute, nothing

will happen because a regular line cannot contain Bézier points 

(you must change its shape first).

Style The line Style.

Line Width The line Width.

Arrowheads The line Arrowheads.

Suppression The line Suppress Printout.

Color The line Color.

Shade The line Shade.

Gap The line Gap settings, including Color and Shade.

Text Path (Lines with Text Content only) The line Text Path settings,

including Text Orientation, Text Alignment and Flip Text.

Note: The current version of Badia Duplica does not support copy-

ing and pasting the Runaround line attribute. ■

Examples

Example 1. Aligning orthogonal lines

We’ll show you how you can align a group of horizontal and vertical

orthogonal lines precisely. Suppose you have the following situation –

a group of vertical lines that need to butt against two horizontal lines:

First, select the top horizontal line and choose Copy Line Attributes.

Check only First Point Down:

22

Badia Duplica XT

Duplica Tip
Duplica “remembers” the

buttons that you checked

after closing a dialog. Next

time you perform a Copy
operation, those options

will be checked by default.

(Click the None button if

you want to start over.)



Now, select all the vertical rules at once and choose Paste or

Command-V:

Next, select the bottom horizontal line and choose Copy Line

Attributes. Check only Last Point Down. Select all the vertical rules

again and choose Paste:

Example 2. Working with line shapes

In this example, we are going to create a line design, copy its attrib-

utes and paste them into a group of lines.

Let’s suppose you have the following design:

We will modify one of the line’s design by adding some segments,

and changing its Style, Width, Color, Shade and Text Path settings.

continues 
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Duplica Tip
Here’s an easy way to draw

an object along a path:

1. Begin by drawing the path:

2. Create a new dotted dash

with gaps that resemble the

spacing between the objects

in the path, and paint the

line with that style, adjust-

ing its width:

3. Select the line and con-

vert it to a Bézier box

(Item -> Shape -> Bézier
box). Split the outside

paths (Item -> Split ->
Outside Paths) and group

the result:

4. Paint the object that 

you want to use. We used a

Zapf Dingbats character

converted to box (Style ->
Text to Box). Copy these

box attributes using

Duplica: Width, Height,
Shape, Points and Color:

5. Select the grouped dots

and choose Paste:
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We can now copy the line’s style and apply it to the remaining lines.

Select Copy Line Attributes with these settings:

Note that we are also copying the line’s boundary Width: if you

don’t specify this attribute, all the lines will retain their existing

width (which means that the Bézier points will all be located at 

the same vertical position). 

To finish, select the remaining lines and choose Paste:
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■

Duplica Tip

You can also access any of

Duplica’s menus by pressing

the Shift and Control

keys and clicking anywhere

in a document.



Copying and Pasting Page Attributes

Duplica even allows you to copy and paste horizontal and vertical

guides. These now become “page attributes.” 

With any document open, you can choose Copy Page Attributes and

the following dialog appears:

Horizontal and Vertical Page Guides refer to guides that were 

created within the page limits; Horizontal and Vertical Spread

Guides are the ones created in the pasteboard area.

Once you copy page attributes, you can go to other pages of the

document (including master pages) and choose Paste to apply the

guides that you copied previously.

The page whose guides you are copying (or pasting into) is the 

current page. You can determine the current page at any given moment

by looking at the lower left corner of your document window.

Note: As with any guide operation in QuarkXPress, you cannot

undo pasting page attributes. ■

Using Next Paste

A unique and powerful Duplica feature allows you not only to store

copy operations separately from each other, but also to switch

between them, specifying which one will be the next to be pasted.

You do this by using the Next Paste submenu.

As mentioned earlier, you never lose the contents of the Clipboard

after copying any attribute; instead, they get stored in several sepa-

rate “clipboards.” Every time you perform a copy operation – to 

the Clipboard or “clipboards” – you are automatically changing the

Next Paste. 
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The current page.

The Next Paste submenu
under the Edit menu.

QuarkXPress Tip
To delete all the horizontal

guides in a page, Option-
click the horizontal ruler;

to delete all the vertical

guides, Option-click the

vertical ruler. (Make sure

that the page “touches” 

the top left corner of the

document window). 

You can do the same 

for spread guides, but

clicking on an area of 

the rulers that “touches”

the pasteboard.



For example, let’s suppose that you copy some text to the Clipboard.

The Next Paste becomes “Paste the Contents of the Clipboard.” 

If you copy Character Attributes later on, the Next Paste becomes

“Paste Character Attributes.” If you check the Next Paste submenu,

it should look like this:

Note that there is a checkmark beside Character Attributes: this tells

you that the next time you perform a Paste operation (by choosing

Paste or Command-V), the character attributes that you copied pre-

viously will be pasted, not the contents of the Clipboard.

But you should also note that you can now switch back to 

pasting the contents of the Clipboard. Just select Next Paste -> 

from Clipboard:

After you select from Clipboard, a checkmark will appear next to

that option. Now if you select Paste, the contents of the Clipboard

will be pasted.

Let’s now copy some box attributes. The Next Paste submenu will

look like this:
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Duplica Tip
The Next Paste changes

automatically every 

time you perform a new 

Copy operation.

Duplica Tip
You can still paste box

attributes into a group that

contains boxes and lines:

the attributes will be past-

ed only onto the boxes, 

not the lines. The same is

true for pasting line attrib-

utes into a group that 

contains boxes as well: the

attributes will be pasted

only onto the lines.



Box Attributes now become the Next Paste. Again, you can always

switch back to any of the previous clipboards. 

The contents of Duplica’s clipboards remain available even after you

close or change documents. They will be erased, however, when you

quit QuarkXPress (except the Mac OS Clipboard).

Depending on the selection and the status of the clipboards, Duplica

is smart enough to make available in the Next Paste submenu 

only the options that you can choose from, and it greys out the ones

that are not applicable. In the previous example, if you deselect 

all the boxes in the document, you will now not be able to switch to

Character Attributes or Box Attributes, because you can’t paste

them anyway at that point. However, this does not mean that any of

the clipboard contents are erased – just select any box or text and

those options will be available again.
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Duplica Tip
The contents of Duplica’s

clipboards remain available

even after you close or

change documents. 

Duplica Tip
If you copy something 

to the Clipboard from 

a different application and

you want to paste it into

a QuarkXPress document,

make sure that you select

from Clipboard in the 

Next Paste submenu.



3. Cloning Boxes and Lines with Duplica
You can clone any kind of box or line using Duplica’s powerful

Clone feature. Cloning an item is similar to using XPress’s Step and

Repeat command, but Duplica allows you to specify several other

attribute offsets that can change with each duplication. You can cre-

ate up to 999 copies with one single clone operation.

With an item selected with the Content or Item tools, choose Clone

from the Item menu or use Duplica’s pop-up menu. The following

dialog appears:

This dialog allows you to enter values for different item attribute

incremental offsets. An item attribute incremental offset is the value

that will be added (or subtracted) from the previous attribute value

to generate the new cloned item. For example, cloning a box that

has a 1pt frame with a Frame Width offset of 1pt means that the

frame will increase 1pt with each duplication, resulting in cloned

boxes with 2pt, 3pt, 4pt, ... frame widths.

Note: The current version of Badia Duplica does not allow you to

clone grouped items. ■

28

Badia Duplica XT

Duplica Tip
Use the Clear All button to

return every field in the

Clone dialog to 0 and dis-

able the Rotate Around
Point feature.

Duplica’s Clone menu item
under the Item menu.



Specifying Incremental Offsets 

Here’s a description of each of the clone incremental offsets:

Across The offset Across the page. This is identical to Step and

Repeat’s Horizontal Offset.

Down The offset Down the page. This is identical to Step and

Repeat’s Vertical Offset.

Width (Boxes and Bézier lines only) The box or Bézier line Width

increment.

Height (Boxes and Bézier lines only) The box or Bézier line Height

increment.

Width (Boxes and Bézier lines only) The box or Bézier line Width

increment.

Angle (Boxes and Bézier lines only) The box or Bézier line Angle

increment.

Skew (Boxes and Bézier lines only) The box or Bézier line Skew

increment.

Corner Radius (Rectangular boxes only) The box Corner Radius

increment.

Frame Width / Line Width For boxes, this is the Frame Width incre-

ment; for lines, this is the Line Width increment.

Shade For boxes, this is the background Shade increment; for lines,

it’s the line Shade increment.

Frame (Boxes only) The box frame Shade increment.

Note: Shade offsets are only available for items with a color other

than None. ■

Rotating an Item Around a Point 

A unique Duplica feature allows you to rotate and clone an item

around a point within a page, in much the same way illustration

programs do. You can use any of the previously described incremen-

tal offsets simultaneously with each cloned item rotation.
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Duplica Tip
After cloning an item, the

Duplicate menu item under

the Item menu changes 

to Clone Again. If you use

XPress’s Step and Repeat
command, Clone Again
switches back to Duplicate.

The keyboard command 

is always 1 D.

Duplica Tip
You can undo and redo
clone operations by simply

pressing 1 Z or, from the

menu, Edit -> Undo/Redo
Cloning.



The rotation will take place around the Rotation Point within 

the page. You specify the rotation point by entering the values in the

Point Across and Point Down fields. These values are measured

from the edge of the page, independent of the location of the ruler

origin. With each step, you also have to specify the angle that will be

used to rotate the cloned item in relation to the previous one. You

do this by entering a value in the Angle Step field:

In this case, the rotation point is 7p across from the left side of the

page and 20p down from the top of the page and each item will be

rotated 45º around it. 

The rotation always takes place from the center of the item to the

rotation point:

Specifying Copies

To specify the number of copies that you want to make, enter

a number from 1 to 999 in the Count field. There are also

two check buttons that you can set on and off: if you check

the Paste Behind button, each cloned copy will be placed

behind the previous one, or on top of the previous one if you

uncheck it; checking the Group button will group all the cloned copies

(except the original), otherwise they will remain ungrouped.

30

Badia Duplica XT

Original box
Rotation point

First clone

Second clone

Duplica Tip
You can use any of 

the incremental offsets 

simultaneously as you

rotate an item around 

a point.

Specifying number of clone
copies as well as Paste
Behind and Group settings.



31

Cloning Boxes and Lines with Duplica

Cloning “Zero Copies”

As a “bonus,” you can also enter 0 (zero) in the Count field of the

Clone dialog. You may have already guessed what this does: it 

will modify the original item with the offsets and/or rotation that

you specified without creating any clone. 

Here’s a case in which you may find this feature useful: let’s suppose

that you want to increase the width of a box from its center until a

certain overflow text fits in it. Just enter 1pt (or any appropriate

value) in the Width Boundary Offset field (0.5 pt for the left side and

0.5pt for the right side), and 0 in the Count field. Select Clone Again

repeatedly or Command-D until the text fits the box:

Because Duplica applies incremental offsets from the center of the

item, note that the box center always remains the same in each step.

Duplica Tip
The Width, Height, Angle
and Skew incremental off-

sets are always applied from

the center of the item.

A box with overflow text.

The same box cloned “0 times” with a
1pt Width incremental offset

The same box after pressing 1 D.

The same box after pressing 1 D.

The same box after pressing 1 D.

The same box after pressing 1 D. 
Now the text fits the box.

The center of the box remained the
same in each Clone Again operation

Original box left and right margins.

Duplica Tip
You can create up to 

999 copies with one single

clone operation.



Examples

Example 1. Cloning a beveled-corner box

In this example, we are going to clone, in several different ways, 

a beveled-corner box that has a corner radius of 1p6 and a black

frame of 0.5 pt.

In the Clone dialog box, we only enter the Width and Height fields,

adding a 6pt offset for each of the 10 steps, and we paste every

cloned item behind the previous one:
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Original box to be cloned.

If we clone the same box with those settings but add a Corner

Radius offset of 3pt, we get this:

continues

Duplica Tip
Duplica’s pop-up menu also

conveniently contains

XPress’s Step and Repeat
menu item.
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If instead of +3pt we use –3pt:

And with 1p:

Finally, the following snapshot shows the same box cloned 20 times,

with  no Corner Radius offset and a Frame Shade offset of –5% :

Duplica Tip
Duplica clones as many
items as it can, even if

some of them fall outside

the pasteboard area or

another kind of error is

generated for some items.



Example 2. Creating a Bézier line with a 3D effect

We are going to use Duplica’s Clone feature to create a realistic 3D

effect with a Bézier line. 

First, we begin by painting the following 1pt Bézier line with a 0%

shade of blue:

Now, we create a new dash (Edit -> Dashes & Stripes) that has a

rounded endcap, and use it for the Style of our line (Item -> Modify
-> Style): 

Next, we use Duplica’s Clone with these settings:
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Because our original line had 0% shade and a width of 1pt, in each

step the cloned lines will have 1%, 2%, 3%, ... 99% shade of blue,

and a width of 1.25pt, 1.5pt, 1.75pt, ... 25.75pt, respectively.

Here’s the final result:

Example 3. Rotating and cloning single items to create circular frames
and complex symmetrical shapes 

In this example, we are going to rotate simple shapes with Duplica

to create circular frames and complex shapes.

We begin by placing two guides in the position of the rotation point:

a vertical guide located at 3.5" across and a horizontal guide at 4"

down. We place the object that we are going to rotate centered on

the horizontal rule (in this case, a triangle):

Duplica Tip
The rotation always takes

place from the center of the

item to the rotation point.

Rotation point

We are going to rotate and clone the triangle around the rotation

point by 5º with each duplication. To cover a complete circle, we

will need 71 steps (360º / 5º = 72, minus 1 because we already have

the original triangle). Note that this will always keep our triangle

pointing to the right, so we also need to rotate each copy around its

center by 5º:



Here’s the result:

For our final example, we are going to rotate and clone a Bézier

shape placed at the rotation point to create a more complex shape:
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Duplica Tip
To place a cloned item at

exactly the same position

as the original item, open

Duplica’s Clone dialog 

and click the Clear All but-

ton. This will reset all the

attribute offsets to zero, 

deselect Rotate Around
Point and set the Count
field to 1. The cloned item 

will be placed in front or 

behind the original item,

depending on the status of

the Paste Behind button.
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We’ll use a Geometry Angle and Step Angle of 10º, and 35 copies 

(360º / 10º = 36, minus 1): 



38

Badia Duplica XT



Appendix: Warnings and Error Messages
Pasting attributes into this multiple selection cannot be undone. 
OK to continue?
You are attempting to paste box or line attributes into a group of

boxes or lines (or both). This operation cannot be undone. Save

your document first, or experiment with just one item if you are not

sure about the final results.

One or more cloned items cannot be pasted because they are off 
the pasteboard.
Some items can not be cloned during the clone operation because

they fall outside the pasteboard area. However, Duplica clones as

many items as it can.

One or more attributes cannot be pasted because: _________
An error occurs while attempting to paste an attribute. Some attrib-

utes may be applied, since Duplica stops only when QuarkXPress

reports an error.

One or more attributes cannot be pasted because errors occurred, 
including:  _________
Errors occurred while attempting to paste attributes in a multiple

item selection and the last of those errors is displayed. Duplica 

pasted as many attributes as it could with the rest of the items.

Cannot paste the attribute Color because the color _________ does not
exist in this document.
You are attempting to paste the Color attribute of a color name that

no longer exists. Duplica will not paste this attribute.

Badia Duplica XT cannot be used with this version of QuarkXPress.
Duplica can only be used with QuarkXPress 4.03 or higher for

Power Macintosh.

Too many copies of Badia Duplica XT with serial number ____________
are already running.
You cannot use a copy of Badia Duplica with the same serial 

number in more than one computer at once. Some QuarkXPress

menu items may not be available. Use the XTensions Manager to 

disable Badia Duplica and restart QuarkXPress. Please contact

Badia Software for information on how to purchase a site license 

for Badia Duplica.
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